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OptionStation Pro 
 
OptionStation Pro is your options trading control center. In this window, you can view 
all options for any optionable stock in real time. With OptionStation Pro, you can 
create, analyze and monitor any number of actual or theoretical options positions, then 
place and track your trades.  
 
OptionStation Pro opens in its own window. Simply click on the OptionStation Pro icon 
in the TradingApps Launcher.  
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OptionStation Pro displays four panels by default: Asset, Option Chains, Theoretical Positions and Real 
Positions. There are five additional panels that are displayed as tabs in different parts of the platform: 
Settings, 2D Graph, 3D Graph, Order Bar and Orders. You may click on any tab to roll out the panel.  
Panels can also be pinned to OptionStation Pro by clicking on the pin icon at the top right corner of the 
panel. 
 
You may customize the location, size and layout of the panels to match your style of trading. To return the 
panels to their original size and position, click on the File menu at the upper left of OptionStation Pro and 
select Reset to Default. 
 
Each panel is designed to give you information about a specific area of your options analysis and trading. 
Each has its own set of analysis columns that can be modified and customized to your trading 
requirements.  
 
The Asset panel gives you real-time price analysis of the underlying asset. Enter the desired symbol in 
the Symbol box on the left of the Asset panel. The Symbol box displays a drop-down list that 
automatically fills when characters are typed in the Symbol box. Once the desired symbol is displayed in 
the Symbol box, OptionStation Pro will load the data that is associated with the symbol. The symbol 
description is displayed the Symbol box.  
 

 
 
The Option Chains panel gives you real-time options price analysis, including implied volatilities, Greek 

risk measures and probability information. Options are listed under label rows that display the expiration 
month and year; these can be expanded by clicking the plus sign on the left. Strike prices run down the 
middle of this section, with calls on the left and puts on the right.  
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Options are also listed and grouped based on the type 
of spread selected in the Type drop-down. This drop-
down allows you to organize and build all of the 
available options into numerous combinations of 
positions for a specific spread. This helps you 
compare, analyze and select the right options strategy 
for your objectives. The Option Chains panel displays 
the total premium for the spread (bid, ask or mid 
prices) as well as the composite Greeks and volatility 
values.   
 
The number of strike prices and expiration dates 
displayed in the Option Chains panel is controlled by 
the Option Chains settings found in the Settings 
panel. This allows you to view only those options that 
are relevant to your trading.  
 
The columns in the Spread Chains panel can also be 
modified by right-clicking anywhere on the panel and 
selecting Format Columns from the right-click menu. 
Columns such as Delta and Theta show the current 
real-time price risk for each option. There are dozens 
of additional options-related analysis columns that you 
can add to the Spread Chains panel. 

 

Creating Theoretical Options Positions 
 
To enter and analyze a theoretical position, click on the bid or ask for the option or spread. Clicking on the 
left side of the strike column will use calls; clicking on the right side of the strike column will use puts. 
Clicking the bid of the option or spread will create a short position; clicking the ask will create a long 
position. You can build a buy or sell for any of the standard options strategies. The positions created are 
displayed in the Theoretical Positions panel. You can create any number of positions to analyze, chart 
and compare.  
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The Theoretical Positions panel allows you to analyze, chart and monitor multiple options positions in real 
time. You can adjust options position legs on the fly, changing strike, type, expiration date, quantity and 
price to create an unlimited number of potential position scenarios. Use the checkboxes to the left of the 
displayed theoretical positions to select the positions to graph.   
 
The analysis columns in the Theoretical Positions panel display values for both the overall position and 
individual legs. There are many other analysis columns that can be added to this panel by right-clicking 
on the column headers and selecting Format Columns from the right-click menu. 
 
 

Placing a Trade 
 
From the Theoretical Positions panel, you can also turn any position into a trade by clicking the Actions 
button on the right of the panel and selecting Trade. You may also delete a theoretical position by clicking 
on Delete Position from this menu.   

 
Clicking on Trade will send the order details to 
the OptionStation Pro Order Bar. 

 
The OptionStation Pro Order Bar will display 
the options details and you may adjust the order 
settings before placing the order. Once the order 
is filled, the position will appear in the Real 
Positions panel.   
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Managing Orders 

 
You may click on the Orders tab at the bottom of OptionStation Pro to view the real-time status of orders 
entered during the current trading day.  Orders are color-coded based on their status.  You may cancel or 
replace an active order by clicking on the Cancel… button.   
 

 
 

Managing Real Positions 
 
The Real Positions panel is where your open positions will be listed.  By default, positions are grouped 
by Underlying.  You may group positions differently by clicking and dragging the column headers for 
Underlying, Account, Expiration or spread Type into the top area of the Real Positions panel.   
 

 
 
Filled positions first appear as individual legs in the Real Positions panel. Click the + button on the left of 

the row to view more details.  Using the green arrow button   on the right side of each leg row, you can 
split the leg into additional legs, delete the leg or send an order to close the leg.  
 
You can also re-combine legs into real spread positions using OptionStation Pro's SpreadMaster feature. 
For example, you can create named spreads from existing legs to make it easier to keep track of your 
positions and to close spreads with a single order. 
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SpreadMaster 
 
SpreadMaster allows you to reconstruct two or more filled option legs into named spreads so that you can 
manage your real positions as spreads. When theoretical spreads are filled in the market, they are 
"stripped" of their spread name (identity) and single legs are returned. You can combine filled leg 
positions into real position spreads, making it easier to manage your leg positions. 
 

 
 
Create a new and empty real spread by clicking the Actions button to the right of a spread row and 
selecting Create New Position from the pop-up menu. A spread named Custom will appear at the 
bottom of the list. Drag legs onto the new Custom spread title row one at a time. A + sign appears to the 
left of the Custom spread row indicating where the leg will be added. Using spread-recognition 
technology, the name of the spread will change automatically as determined by the combination of legs, 
prices and expirations.  
 
Individual common legs (i.e., those that represent the same side, type, price and expiration) can have 
their quantities added together into a single leg. To do this, click the Actions button to the right of a 

spread row and select Merge Common 
Legs from the pop-up menu.  
 
You may also click the Actions button to 
the right of a spread row to Lock 
Position.  A lock icon will appear to the 
left of the spread row, indicating that the 
real spread and its legs are locked and 
cannot be accidentally added to or 
removed without first unlocking.  
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Graphing Options Positions 
 
The 2D Graph and 3D Graph panels are your options scenario testing tools. They allow you to 
graphically represent and evaluate the profit, loss and other risk measures for any options position or 
strategy, based on changes in asset price, time to expiration and volatility.  
 
Below the position graph, the probability curve shows the probability of the underlying asset’s price 
movement based on the asset’s volatility and the time left to expiration. It shares the same X-axis as the 
spread profile representing the underlying asset price. However, the Y-axis along the left shows the 
number of days to expiration.  
 

 
 
Position graphs also allow you to compare one or more potential positions and determine the relative 
risk/reward ratios, breakeven points and maximum gain and loss points. In addition, possible changes in 
the asset price and volatility can also be factored into your decision-making process. 
 
Graphs are created by selecting positions from the Theoretical Position panel or the Real Positions 
panel. Click the checkbox next to any position and the graph will automatically appear. You may select 
multiple positions simultaneously and the graph will adjust accordingly. You are able to see your spread 
in a classic, two-dimensional plot as well as a three-dimensional view that can provide a more expanded 
profile of the overall effects of time and volatility. To view either the 2D Graph or 3D Graph, click on the 
corresponding tab next to the Option Chains tab.  
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The graph can draw up to four plots representing four different dates between now and the day of 
expiration. The number of plots can be changed from the Settings panel. By default, the graph type is set 
to theoretical profit and loss, but you may also graph the Greeks (Delta, Gamma, Theta, Vega or Rho).  
 
At the bottom of the 2D Graph panel, you will find an area where different price points can be defined for 
real-time analysis and monitoring. This is very helpful in determining what a profit or loss might be if the 
underlying asset price were to change 5% or 10% higher or lower. You can also see how the Greeks will 
behave with changes in the underlying stock.  
 

 
 
Click Add at the top left corner of this section to add different price points. Clicking on the actual price will 
enable you to modify price by either using the scroll bar or typing over the current price shown. The color 
dots to the left of the prices correspond to the color of the vertical lines displayed in the 2D Graph.    
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Formatting OptionStation Pro Settings 
 
By default, the Settings panel is displayed in the upper right corner of OptionStation Pro. If the Settings 
panel is not visible, click on the View menu and select Settings to make it reappear. 
 

The Common section lets you manage 
settings that apply to the source and 
calculation parameters for volatility.  
 
The Graph section allows you to define the 
view in your risk graph based on the 
parameters you select. This is a valuable tool 
in evaluating potential trades and testing how 
they would profit from market changes and 
time variables. 
 
The 2D Graph Settings is a sub-section of the 
Graph section that includes settings to control 
the number of plots and their appearance in 
the 2D Graph panel. 
 
The Option Chains section allows you to 
include weekly, quarterly and non-standard 
options. 
 
The Real Positions Panel section lets you 
specify the TradeStation account from which 
you want to view your real (existing) positions 
and whether or not to include closed positions. 
  
The Order Settings section specifies the 
default TradeStation account number you 
want to use for placing orders. 
  
A brief description will appear at the bottom of 
the Settings panel for any item that is 
selected.  For example, clicking on Interest 
Rate displays the information below. 
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IMPORTANT INFORMATION: 
 
No offer or solicitation to buy or sell securities, securities derivative, futures Products or off-exchange foreign currency (forex) transactions of any kind, 
or any type of trading or investment advice, recommendation or strategy, is made, given or in any manner endorsed by any TradeStation affiliate and 
the information made available on this Website is not an offer or solicitation of any kind in any jurisdiction where any TradeStation affiliate is not 
authorized to do business, including but not limited to Japan. 
 
Past performance, whether actual or indicated by historical tests of strategies, is no guarantee of future performance or success. There is a possibility 
that you may sustain a loss equal to or greater than your entire investment regardless of which asset class you trade (equities, options futures or 
forex); therefore, you should not invest or risk money that you cannot afford to lose. Options trading is not suitable for all investors. Your account 
application to trade options will be considered and approved or disapproved based on all relevant factors, including your trading experience. Please 
click here to view the document titled Characteristics and Risks of Standardized Options. Before trading any asset class, customers must read the 
relevant risk disclosure statements on our Other Information page. System access and trade placement and execution may be delayed or fail due to 
market volatility and volume, quote delays, system and software errors, Internet traffic, outages and other factors. 
 
TradeStation Group, Inc. Affiliates: All Proprietary technology in TradeStation is owned by TradeStation Technologies, Inc. Equities, equities options, 
and commodity futures Products and services are offered by TradeStation Securities, Inc. (Member NYSE, FINRA, NFA and SIPC). TradeStation 
Securities, Inc.’s SIPC coverage is available only for equities and equities options accounts. Forex Products and services are offered by TradeStation 
Forex, a division of IBFX, Inc. (Member NFA). 
 
Copyright © 2001-2013 TradeStation Group, Inc. 

http://www.tradestation.com/site-wide-items/disclaimers/legal/disclosures/characteristics-standardized
http://www.tradestation.com/other-information
http://www.nyse.com/
http://www.finra.org/index.htm
http://www.nfa.futures.org/
http://www.sipc.org/

